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1. Lưu ý quan trọng

1. Lưu ý quan trọng
Sổ tay sử dụng điện tử này dành cho mọi 
người dùng sử dụng màn hình Philips. 
Hãy dành thời gian đọc sổ tay sử dụng 
này trước khi sử dụng màn hình. Sổ tay 
bao gồm những thông tin và các lưu ý 
quan trọng liên quan đến việc sử dụng 
màn hình.

Chế độ bảo hành của Philips áp dụng với 
điều kiện là sản phẩm phải được sử dụng 
đúng cách theo mục đích sử dụng, theo 
các hướng dẫn hoạt động cùng với việc 
xuất trình hóa đơn gốc hoặc biên nhận 
tiền mặt ghi rõ ngày mua, tên người bán, 
mẫu mã và mã số sản xuất của sản phẩm.

1.1 Lưu ý an toàn và bảo dưỡng

 Cảnh báo
Sử dụng các nút điều khiển, điều chỉnh 
hoặc các quy trình khác ngoài các quy 
trình được nêu rõ trong tài liệu này có thể 
khiến người dùng dễ bị điện giật, gặp các 
rủi ro về điện và/hoặc cơ học.
Hãy đọc và thực hiện theo các hướng dẫn 
sau khi kết nối và sử dụng màn hình máy 
tính.

Hoạt động
•	 Hãy đặt màn hình ở khu vực không có 

ánh sáng trực tiếp của mặt, ánh sáng 
rực có cượng độ mạnh và cách xa 
bất kỳ nguồn nhiệt nào khác. Đặt màn 
hình lâu ngày trong môi trường này có 
thể khiến cho màn hình bị bạc màu và 
hỏng.

•	 Di chuyển mọi đồ vật có thể rơi vào 
các lỗ thông gió của màn hình hoặc 
ngăn cản quá trình làm mát thích hợp 
của các thiết bị điện tử bên trong màn 
hình.

•	 Không bịt kín các lỗ thông gió trên vỏ 
màn hình.

•	 Đảm bảo đặt màn hình ở gần nơi có 
phích cắm và ổ cắm điện.

•	 Nếu tắt màn hình bằng cách rút cáp 
nguồn hoặc dây điện DC, hãy đợi 6 
giây trước khi cắm cáp nguồn hoặc 
dây điện DC để màn hình hoạt động 
bình thường.

•	 Hãy luôn dùng cáp nguồn chuẩn được 
cấp bởi Philips. Nếu thiếu cáp nguồn, 
hãy liên hệ với trung tâm dịch vụ tại 
địa phương bạn. (Vui lòng tham khảo 
mục Trung tâm thông tin tiêu dùng 
chăm sóc khách hàng)

•	 Không đặt màn hình ở nơi bị chấn 
động hay va chạm mạnh khi đang 
hoạt động.

•	 Không đập hoặc làm rơi màn hình khi 
đang hoạt động hoặc khi di chuyển.

Bảo dưỡng
•	 Để màn hình không bị hỏng, không đè 

nén quá mạnh lên mặt màn hình LCD. 
Khi di chuyển màn hình, hãy nắm chặt 
khung màn hình để nhấc lên; không 
nhấc màn hình bằng cách đặt bàn tay 
hoặc ngón tay lên mặt màn hình LCD.

•	 Rút phích cắm màn hình nếu bạn 
không định sử dụng nó trong thời gian 
dài.

•	 Rút phích cắm màn hình nếu bạn cần 
lau chùi màn hình bằng một miếng 
vải hơi ướt. Bạn có thể lau màn hình 
bằng vải khô khi đã ngắt điện. Tuy 
nhiên, đừng bao giờ dùng dung môi 
hữu cơ, chẳng hạn như cồn hoặc các 
chất lỏng có nguồn gốc từ amoniac để 
lau màn hình.

•	 Để tránh nguy cơ bị điện giật hoặc 
hỏng vĩnh viễn bộ màn hình, không 
đặt màn hình ở nơi có bụi, mưa, nước 
hoặc ở nơi quá ẩm ướt.

•	 Nếu màn hình bị ướt, hãy lau nó bằng 
vải khô càng sớm càng tốt.

•	 Nếu chất lạ hoặc nước dính vào màn 
hình, hãy ngắt điện ngay và rút cáp 
nguồn. Sau đó lau sạch chất lạ hoặc 
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nước rồi gửi màn hình đến trung tâm 
bảo dưỡng.

•	 Không cất giữ hoặc sử dụng màn hình 
ở nơi có nguồn nhiệt, ánh nắng trực 
tiếp hoặc quá lạnh.

•	 Để duy trì hoạt động tối ưu của màn 
hình và sử dụng nó trong thời gian dài, 
hãy dùng màn hình ở nơi nằm trong 
giới hạn nhiệt độ và độ ẩm sau.
•	 Nhiệt độ: 0-40°C 32-95°F
•	 Độ ẩm: 20-80% RH

•	 LƯU Ý: Luôn bật trình bảo vệ màn 
hình chuyển động khi bạn không sử 
dụng màn hình. Luôn bật ứng dụng 
làm mới màn hình định kỳ, nếu không, 
màn hình của bạn sẽ hiển thị những 
nội dung tĩnh không thay đổi. Hiển thị 
liên tục các ảnh tĩnh trong một thời 
gian dài có thể gây ra hiện tượng “ảnh 
thử nóng”, còn được gọi là “ảnh ảo” 
hay “ảnh bóng ma”, trên màn hình của 
bạn.

•	 “Ảnh thử nóng”, “Ảnh ảo” hay “Ảnh 
bóng ma” là hiện tượng phổ biến trong 
công nghệ màn hình LCD. Trong hầu 
hết các trường hợp, hiện tượng “ảnh 
thử nóng” hoặc “ảnh ảo” hay “ảnh 
bóng ma” sẽ dần dần biến mất sau 
một thời gian màn hình bị ngắt điện.

 Cảnh báo
Không thể kích hoạt trình bảo vệ màn hình 
hoặc ứng dụng nạp lại màn hình định kỳ 
có thể gây ra các sự cố nghiêm trọng như 
“thử nóng” hoặc “ảnh sau” hoặc “ảnh bóng 
ma” vốn sẽ không biết mất và cũng không 
thể khắc phục. Thiệt hại như trên không 
nằm trong chính sách bảo hành của chúng 
tôi.

Dịch vụ
•	 Chỉ nhân viên dịch vụ chuyên môn 

mới được mở vỏ bọc màn hình.
•	 Nếu cần mọi tài liệu hướng dẫn để 

sửa chữa hoặc tích hợp màn hình, 
hãy liên hệ với trung tâm dịch vụ tại 

địa phương bạn. (vui lòng tham khảo 
chương "Trung tâm thông tin tiêu 
dùng")

•	 Để biết thông tin về việc vận chuyển, 
vui lòng tham khảo mục "Thông số kỹ 
thuật".

•	 Không đặt màn hình trong xe hơi/cốp 
xe dưới ánh nắng trực tiếp.

 Ghi chú
Hãy tham khảo ý kiến của kỹ thuật viên 
dịch vụ nếu màn hình không hoạt động 
bình thường hoặc nếu bạn không chắc 
phải thực hiện quy trình nào khi đã làm 
theo các hướng dẫn hoạt động nêu trong 
sổ tay này.
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1.2 Mô tả biểu tượng
Các mục phụ sau đây mô tả các quy ước 
về biểu tượng dùng trong tài liệu này.

Ghi chú, Lưu ý và Cảnh báo
Trong toàn bộ sổ tay này, các đoạn chữ 
có thể đi kèm biểu tượng và được in đậm 
hoặc in nghiêng. Các đoạn này bao gồm 
các ghi chú, lưu ý hoặc cảnh báo. Chúng 
được sử dụng như sau:

 Ghi chú
Biểu tượng này cho biết các thông tin 
quan trọng và các bí quyết giúp bạn tận 
dụng tốt hệ thống máy tính.

 Lưu ý
Biểu tượng này cho biết các thông tin giúp 
bạn biết cách tránh được sự cố hỏng hóc 
tiềm ẩn đối với phần cứng hoặc mất dữ 
liệu.

 Cảnh báo
Biểu tượng này cho biết sự tổn thương 
cơ thể tiềm ẩn và giúp bạn biết cách tránh 
được sự cố đó.
Một số cảnh báo có thể xuất hiện ở nhiều 
định dạng và có thể không đi kèm một 
biểu tượng. Trong những trường hợp này, 
cách thức trình bày cụ thể của cảnh báo 
đó được quy định bởi cơ quan chức năng 
liên quan.
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1.3 Vứt bỏ sản phẩm và vật liệu 
đóng gói

Thiết bị điện & điện tử bị vứt bỏ-WEEE

This marking on the product or on its 
packaging illustrates that, under European 
Directive 2002/96/EC governing used electrical 
and electronic appliances, this product may 
not be disposed of with normal household 
waste. You are responsible for disposal of 
this equipment through a designated waste 
electrical and electronic equipment collection. 
To determine the locations for dropping 
off such waste electrical and electronic, 
contact your local government office, the 
waste disposal organization that serves your 
household or the store at which you purchased 
the product.

Your new monitor contains materials that 
can be recycled and reused. Specialized 
companies can recycle your product to 
increase the amount of reusable materials and 
to minimize the amount to be disposed of.

All redundant packing material has been 
omitted. We have done our utmost to make 
the packaging easily separable into mono 
materials.

Please find out about the local regulations 
on how to dispose of your old monitor and 
packing from your sales representative.

Taking back/Recycling Information for 
Customers
Philips establishes technically and 
economically viable objectives to optimize 
the environmental performance of the 
organization's product, service and activities.

From the planning, design and production 
stages, Philips emphasizes the important of 
making products that can easily be recycled.  
At Philips, end-of-life management primarily 
entails participation in national take-back 
initiatives and recycling programs whenever 
possible, preferably in cooperation with 
competitors, which recycle all materials 
(products and related packaging material) 
in accordance with all Environmental Laws 
and taking back program with the contractor 
company.  

Your display is manufactured with high quality 
materials and components which can be 
recycled and reused.

To learn more about our recycling program 
please visit

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page
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2. Cài đặt màn hình

2.1 Lắp đặt

 Nội dung gói hàng

 

224E5

2

VGA (tùy chọn)
Cáp âm thanh 

(tùy chọn)

Quản lý cáp DVI (tùy chọn)

Adapter AC/DC  
(điện xoay chiều/một chiều)

  Cảnh báo:

•	 Chỉ sử dụng adapter AC/DC 
kèm theo sản phẩm của Philips.
ADPC1945 (224E5QHSB), ADPC1965 
(224E5QHAB/QHAW/QDAB)

•	 Đối với sản phẩm 224E5QSB/SW, hãy 
tham khảo thông tin điện áp trên nhãn 
thông số trước khi sử dụng adapter.
ADPC1945 for 224E5QSB/SW 
của phiên bản A (Đổi mã số serial)
ADPC1236 for 224E5QSB/SW của 
phiên bản B (Đổi mã số serial)

 

Không xé lớp phủ màn hình

 Lắp chân đế
1. Đặt màn hình nằm sấp trên bề mặt 

mềm mịn, cẩn thận để tránh làm trầy 
xước hoặc hỏng màn hình.

2. Giữ chân đế màn hình bằng cả hai tay 
và lắp chặt chân đế vào trụ đế.
(1) Gắn nhẹ chân đế vào trụ đế cho 

đến khi chốt cài khớp chặt vào 
chân đế.

(2) Dùng ngón tay vặn chặt đinh vít 
nằm ở phía dưới chân đế và siết 
chặt chân đế vào trụ đế.

2

1
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 Kết nối với PC

Mẫu 224E5QSB, 224E5QSW:

12

1

2

3

4

3

 Đầu vào nguồn điện AC/DC
 Đầu vào VGA
 Đầu vào DVI-D
 Khóa chống trộm Kensington

Mẫu 224E5QHAB, 224E5QHAW:

MHL

1

23

7

6

4

1

2

3

5

4

 Đầu vào nguồn điện AC/DC
 Đầu vào VGA
 Đầu vào HDMI
 Đầu vào HDMI hoặc MHL 
 Đầu ra tai nghe
 Đầu vào âm thanh
 Khóa chống trộm Kensington

Mẫu 224E5QHSB:

1

23

6

54

1

2

3

4

 Đầu vào nguồn điện AC/DC
 Đầu vào VGA
 Đầu vào HDMI
 Đầu vào HDMI hoặc MHL
 Đầu ra âm thanh HDMI
 Khóa chống trộm Kensington

Mẫu 224E5QDAB:

MHL

1

23

7

6

4

1

2

3

5

4

 Đầu vào nguồn điện AC/DC
 Đầu vào VGA
 Đầu vào DVI
 Đầu vào HDMI hoặc MHL 
 Đầu ra tai nghe
 Đầu vào âm thanh
 Khóa chống trộm Kensington
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Kết nối với PC
1. Cắm chặt cáp nguồn vào mặt sau của 

màn hình.
2. Tắt máy tính và rút cáp nguồn.
3. Cắm cáp tín hiệu màn hình vào lỗ cắm 

video ở mặt sau máy tính.
4. Cắm cáp nguồn của máy tính và cáp 

nguồn của màn hình vào ổ cắm điện 
gần đó.

5. Bật máy tính và màn hình. Nếu màn 
hình hiển thị hình ảnh thì quá trình cài 
đặt đã hoàn tất.

2.2 Sử dụng màn hình

 Mô tả mặt trước của sản phẩm

Mẫu 224E5QSB, 224E5QSW, 
224E5QHSB:

2

5

6 23 47

BẬT và TẮT nguồn màn 
hình.

Truy nhập menu OSD.

Trở về mức OSD trước.

Đổi định dạng hiển thị.

Chỉnh menu OSD.

Đổi nguồn vào tín hiệu.

SmartImage Lite. Có ba 
chế độ để bạn lựa chọn: 
Standard (Chuẩn), Internet, 
Game.
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Mẫu 224E5QHAB, 224E5QHAW, 
224E5QDAB:

2

5

6 23 47

BẬT và TẮT nguồn màn 
hình.

Truy nhập menu OSD.

Trở về mức OSD trước.

Chỉnh âm lượng loa.

Chỉnh menu OSD.

Đổi nguồn vào tín hiệu.

SmartImage Lite. Có ba 
chế độ để bạn lựa chọn: 
Standard (Chuẩn), Internet, 
Game.

 Mô tả menu Hiển thị trên màn hình

Hiển thị trên màn hình (OSD) là gì?
Hiển thị trên màn hình (OSD) là một tính 
năng có ở mọi màn hình LCD của Philips. 
Nó cho phép người dùng điều chỉnh hoạt 
động của màn hình hoặc chọn các chức 
năng của màn hình trực tiếp thông qua 
một cửa sổ hướng dẫn hiển thị trên màn 
hình. Một giao diện hiển thị trên màn hình 
dễ sử dụng được thể hiện như sau:

Mẫu 224E5QSB,224E5QSW:












 

Mẫu 224E5QHSB,224E5QHAB,224E5QHAW:
















Mẫu 224E5QDAB:















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Hướng dẫn cơ bản và đơn giản về các 
nút điều khiển
Trong menu OSD minh họa ở trên, bạn có 
thể nhấn   các nút ở gờ mặt trước của 
màn hình để di chuyển con trỏ và nhấn nút 
OK để xác nhận lựa chọn hoặc thay đổi.

Menu OSD 
Dưới đây là tổng quan về cơ cấu của 
menu Hiển thị trên màn hình. Bạn có thể 
sử dụng cơ cấu này làm thông tin tham 
khảo khi muốn thực hiện các điều chỉnh 
khác sau này.
Main menu Sub menu

Picture

OSD Settings

Setup

Language

Color

Audio

Input

Picture Format
Brightness

Contrast

Horizontal

Vertical

Transparency

OSD Time Out

H.Position

Auto

V.Position

Phase

Clock

Resolution Notification

Reset

Information

English, Deutsch, Español, Ελληνική, Français, 
Italiano,  Maryar，Nederlands, Português, 
Português do Brazil，Polski，Русский ,Svenska，
Suomi，Türkçe，Čeština，Українська, 简体中文, 
繁體中文，日本語，한국어

Color Temperature

sRGB

User Define

Stand-Alone

Mute

VGA

DVI (available for selective models)

HDMI (available for selective models)

MHL-HDMI (available for selective models)

SmartResponse
(available for selective models)
SmartContrast

Over Scan
(available for selective models)
DPS
(available for selective models)

Pixel Orbiting
(available for selective models)

Volume
(available for selective models)

Audio source Audio in

Wide Screen, 4:3

0~100
0~100

0~100

0~100

Off, 1, 2, 3, 4

5s, 10s, 20s, 30s, 60s

0~100

On, Off

Yes, No

0~100

0~100

0~100

6500K, 9300K

Red: 0~100

 0~100

Green: 0~100

Blue: 0~100

On, Off

On, Off

Off, Fast, Faster, Fastest

On, Off 
On, Off 

On, Off

On, Off

(available for selective models)
1.8, 2.0, 2.2, 2.4, 2.6Gamma

 Thông báo về độ phân giải
Màn hình này được thiết kế để hoạt 
động tối ưu với độ phân giải gốc là 
1920×1080@60Hz. Khi được chỉnh sang 
độ phân giải khác, màn hình sẽ hiển thị 
một thông báo: Use 1920×1080@60Hz 
for best results. (Hãy dùng độ phân giải 
1920×1080@60Hz để có kết quả tối ưu.)

Bạn có thể tắt thông báo hiển thị độ phân 
giải gốc từ mục Cài đặt trong menu OSD 
(Hiển thị trên màn hình).

 Tính năng vật lý

Nghiêng



10

2. Cài đặt màn hình

2.3 Tháo đế và chân đế

 Tháo chân đế
Trước khi bắt đầu tháo chân đế màn 
hình, hãy thực hiện theo các hướng dẫn 
bên dưới để tránh mọi thiệt hại hay chấn 
thương có thể xảy ra.
1. Đặt màn hình nằm sấp trên bề mặt 

mịn, cẩn thận để tránh làm trầy xước 
hoặc hỏng màn hình.

2. Tháo đế giữ.

2

1

3. Tháo nắp bản lề.

4. Nới nỏng bốn vít để tháo trụ đỡ ra

 Ghi chú 
Màn hình này chấp nhận giao diện lắp đặt 
tuân thủ chuẩn VESA 100mm x 100mm.

100mm

100mm
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2. Cài đặt màn hình

2.4 Giới thiệu về MHL (Liên kết 
Độ nét Cao Di động)

 Đây là chức năng gì?
Liên kết Độ nét Cao Di động (MHL) là giao 
diện âm thanh/video di động để kết nối 
trực tiếp điện thoại di động và những thiết 
bị di động khác với các màn hình độ nét 
cao.

Cáp MHL tùy chọn cho phép bạn chỉ cần 
kết nối thiết bị di động tương thích MHL 
với màn hình lớn MHL Philips này, và xem 
các video HD giống như thật với âm thanh 
kỹ thuật số hoàn chỉnh. Giờ bạn không chỉ 
có thể tận hưởng các game di động, ảnh 
chụp, phim, hoặc các ứng dụng khác trên 
màn hình lớn của Philips mà còn có thể 
sạc pin đồng thời cho thiết bị di động để 
bạn không bao giờ hết pin giữa chừng.

 Làm thế nào để sử dụng chức năng 
MHL?
Để sử dụng chức năng MHL, bạn cần có 
thiết bị di động được chứng nhận tương 
thích MHL. Để tìm danh sách các thiết bị 
được chứng nhận tương thích MHL, hãy 
truy cập trang web MHL chính thức (http://
www.mhlconsortium.org)

Bạn cũng cần có cáp tùy chọn đặc biệt 
được chứng nhận tương thích MHL để sử 
dụng chức năng này.

 Chức năng này hoạt động như thế 
nào? (cách kết nối?)
Hãy cắm cáp MHL tùy chọn vào cổng USB 
mini trên cạnh thiết bị di động và cổng 
được đánh dấu [MHL-HDMI] trên cạnh 
màn hình. Giờ bạn sẵn sàng xem các hình 
ảnh trên màn hình lớn của mình và thực 
hiện mọi chức năng trên thiết bị di động 
như lướt web, chơi game, duyệt xem ảnh 
chụp, v.v... Nếu màn hình có chức năng 
loa, thì bạn cũng có thể nghe âm thanh 
kèm theo. Khi ngắt kết nối cáp MHL hoặc 
tắt thiết bị di động, thì chức năng MHL 
cũng sẽ tự động tắt theo

MHL-HDMI

MHL

 Ghi chú
• Cổng được đánh dấu [MHL-HDMI] là 

cổng duy nhất trên màn hình vốn hỗ 
trợ chức năng MHL khi sử dụng cáp 
MHL. Lưu ý rằng cáp được chứng 
nhận tương thích MHL sẽ khác so với 
cáp HDMI chuẩn.

• Bạn phải mua riêng thiết bị di động 
được chứng nhận tương thích MHL

• Bạn có thể phải chuyển màn hình 
theo cách thủ công sang chế độ MHL-
HDMI để kích hoạt màn hình nếu có 
những thiết bị khác đang sẵn sàng 
hoạt động và được kết nối với các đầu 
vào có sẵn

•	 Chế độ chờ/Tắt tiết kiệm năng lượng 
ErP không áp dụng cho chức năng sạc 
pin MHL

• Màn hình Philips này được chứng 
nhận tương thích với MHL. Tuy nhiên, 
khi thiết bị MHL của bạn chưa kết 
nối hoặc hoạt động không thích hợp, 
hãy kiểm tra mục Hỏi Đáp về thiết bị 
MHL hoặc liên hệ trực tiếp nhà cung 
cấp để được chỉ dẫn. Chính sách của 
nhà sản xuất thiết bị có thể yêu cầu 
bạn mua cáp hoặc adapter MHL riêng 
thuộc nhãn hiệu của họ để hoạt động 
với các thiết bị MHL thuộc nhãn hiệu 
khác. Lưu ý rằng đây không phải là lỗi 
từ màn hình Philips.
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3. Tối ưu hóa hình ảnh

2. Tiếp tục nhấn  để chuyển giữa 
Standard (Chuẩn), Internet, Game.

3. Menu OSD SmartImage Lite sẽ vẫn 
hiển thị trên màn hình trong 5 giây 
hoặc bạn cũng có thể nhấn OK để xác 
nhận lựa chọn.

4. Khi SmartImage Lite đã được bật, bố 
cục sRGB sẽ tự động tắt. Để dùng 
sRGB, bạn phải tắt SmartImage Lite 
bằng nút  ở gờ mặt trước của màn 
hình.

Nếu không dùng nút  để cuộn xuống, 
bạn cũng có thể nhấn các nút   để chọn 
và nhấn nút OK để xác nhận lựa chọn và 
đóng menu OSD SmartImage Lite.

Có ba chế độ để bạn lựa chọn: Standard 
(Chuẩn), Internet và Game.









• Standard (Chuẩn): Làm rõ chữ và 
giảm độ sáng giúp bạn dễ đọc chữ và 
bớt mỏi mắt. Chế độ này tăng đáng kể 
sự rõ ràng của nội dung chữ và hiệu 
suất khi bạn làm việc với các bảng 
tính, file PDF, các bài mục scan hoặc 
các ứng dụng văn phòng khác nói 
chung.

• Internet: Cấu hình này kết hợp bão 
hòa màu sắc, linh hoạt tăng độ tương 
phản và sắc nét để hiển thị ảnh chụp 
và các hình ảnh khác với độ rõ nổi bật 
cùng màu sắc sống động - tất cả mọi 
thứ mà không hề có dấu vết của màu 
sắc nhạt và giả tạo.

• Game: Tăng mạch truyền động để có 
thời gian đáp ứng tối ưu, giảm các 
bờ lề gai góc cho các đối tượng di 
chuyển nhanh trên màn hình, tăng độ 
tương phản cho bố cục sáng và tối, 
cấu hình này mang lại cho người chơi 
trải nghiệm chơi game tốt nhất.

3. Tối ưu hóa hình ảnh

3.1 SmartImage Lite

 Đó là gì?
SmartImage Lite cung cấp các chức năng 
cài đặt sẵn giúp bạn tối ưu hóa màn hình 
để sử dụng cho các kiểu nội dung khác 
nhau, linh hoạt chỉnh độ sáng, độ tương 
phản, màu sắc và độ sắc nét khi sử dụng 
thực tế. Dù làm việc với các ứng dụng 
bằng chữ, hiển thị hình ảnh hay xem 
video, Philips SmartImage Lite cũng mang 
lại cho bạn hiệu quả màn hình tối ưu nhất.

 Sao tôi phải cần nó?
Bạn muốn một màn hình hiển thị tối ưu 
mọi kiểu nội dung ưa thích, phần mềm 
SmartImage Lite sẽ linh hoạt chỉnh độ 
sáng, độ tương phản, màu sắc và độ sắc 
nét khi sử dụng thực tế nhằm nâng cao 
trải nghiệm xem màn hình của bạn.

 Cách hoạt động?
SmartImage Lite là công nghệ độc quyền 
tiên tiến của Philips vốn sẽ phân tích các 
nội dung hiển thị trêm màn hình của bạn. 
Dựa trên bối cảnh sử dụng mà bạn lựa 
chọn, SmartImage Lite sẽ linh hoạt cải tiến 
độ tương phản, bão hòa màu sắc và độ 
sắc nét của hình ảnh để cải thiện nội dung 
đang hiển thị - tất cả khi sử dụng thực tế 
chỉ với duy nhất một cú nhấn nút.

  Cách bật chức năng SmartImage Lite?

2

1. Nhấn  để khởi động SmartImage 
Lite trên màn hình;
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3. Tối ưu hóa hình ảnh
 Cài đặt

• Thực hiện theo chỉ dẫn và hoàn tất 
quy trình cài đặt.

• Bạn có thể khởi động phần mềm sau 
khi hoàn tất cài đặt.

• Nếu muốn khởi động sau, bạn có thể 
click phím tắt phần mềm trên màn 
hình nền hoặc thanh công cụ máy 
tính.

Thuật sĩ khởi động lần đầu
• Lần đầu khi cài đặt phần mềm 

SmartControl Lite, nó sẽ tự động vào 
Thuật sĩ khởi động lần đầu.

• Thuật sĩ này sẽ hướng dẫn bạn thông 
qua việc điều chỉnh từng bước về hiệu 
suất màn hình.

• Sau này bạn cũng có thể vào menu 
Plug-in (Bổ sung) để bật thuật sĩ.

• Bạn có thể chỉnh các tùy chọn khác 
qua giao diện Standard (Chuẩn) mà 
không cần thuật sĩ.

3.2 SmartContrast

 Đó là gì?
Công nghệ độc đáo vốn linh hoạt phân 
tích nội dung hiển thị và tự động tối ưu 
hóa tỷ lệ tương phản của màn hình LCD 
để mang lại độ rõ nét và trải nghiệm xem 
tối ưu, tăng mức đèn nền để hiển thị 
những hình ảnh sáng rõ hơn, sắc nét hơn 
và sống động hơn hay giảm mức đèn nền 
để hiển thị rõ hình ảnh trên phông nền tối.

 Sao tôi phải cần nó?
Bạn muốn hiển thị nội dung rõ nét cùng 
cảm giác thoải mái nhất khi xem mọi loại 
nội dung. SmartContrast sẽ linh hoạt chỉnh 
độ tương phản và mức đèn nền để hiển 
thị những hình ảnh chơi game hay video 
cực rõ, sống động và sắc nét hay hiển thị 
nội dung chữ rõ ràng dễ đọc cho các ứng 
dụng văn phòng. Bằng cách giảm việc tiêu 
thụ điện của màn hình, bạn sẽ tiết kiệm 
được chi phí năng lượng và kéo dài tuổi 
thọ cho màn hình của bạn.

 Cách hoạt động?
Khi bạn bật chế độ SmartContrast, nó sẽ 
phân tích nội dung đang hiển thị trong 
thực tế để chỉnh màu sắc và mật độ đèn 
nền. Chức năng này sẽ linh hoạt tăng 
độ tương phản để mang lại cho bạn trải 
nghiệm giải trí tuyệt vời khi xem video 
hoặc chơi game.

3.3 Philips SmartControl Lite
Phần mềm SmartControl Lite mới của 
Phillips cho phép bạn điều khiển màn hình 
qua giao diện đồ họa ảo tiện dụng. Các 
điều chỉnh phức tạp là những gì thuộc về 
quá khứ vì phần mềm thân thiện với người 
dùng này sẽ hướng dẫn bạn qua việc tùy 
chỉnh độ phân giải, hiệu chỉnh màu, điều 
chỉnh đồng hồ/góc pha, điều chỉnh điểm 
trắng RGB (Đỏ-Lục-Lam), v.v...

Trang bị công nghệ mới nhất về thuật toán 
lõi xử lý và phản ứng nhanh, phần mềm 
chạy bằng ảnh động bắt mắt thương thích 
với Windows 7 này sẵn sàng nâng cao trải 
nghiệm của bạn với màn hình Philips!
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3. Tối ưu hóa hình ảnh
  Khởi động bằng giao Standard (diện 

Chuẩn):

Menu Adjust (Điều chỉnh):
• Menu Adjust (Điều chỉnh) cho phép 

bạn chỉnh Brightness (Độ sáng), 
Contrast (Độ tương phản), Focus 
(Trọng tâm), Position (Vị trí) và 
Resolution (Độ phân giải).

• Bạn có thể làm theo chỉ dẫn và thực 
hiện điều chỉnh.

• Lệnh Cancel (Hủy) sẽ hỏi người dùng 
xem họ có muốn hủy tiến trình cài đặt 
hay không.
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3. Tối ưu hóa hình ảnh
Menu Color (Màu):
• Menu Color (Màu) cho phép bạn chỉnh 

màu RGB (Đỏ-Lục-Lam), Black Level 
(Độ tối), White Point (Điểm trắng), 
Color Calibration (Hiệu chỉnh màu) và 
SmartImage Lite (Vui lòng tham khảo 
mục SmartImage Lite).

• Bạn có thể làm theo chỉ dẫn và thực 
hiện điều chỉnh.

• Tham thảo bảng bên dưới để hình 
dung cơ bản về mục menu phụ trên 
thông tin nhập của bạn.

• Ví dụ Color Calibration (Hiệu chỉnh 
màu sắc):

1. "Show Me" (Cho tôi xem) sẽ bật 
hướng dẫn hiệu chỉnh màu.

2. Start (Bắt đầu) - bắt đầu quy trình 
canh chỉnh màu qua 6 bước.

3. Quick View (Xem nhanh) tải các hình 
ảnh trước/sau.

4. Trở về giao diện chính Color (Màu), 
click nút Cancel (Hủy).

5. Enable color calibration (Bật hiệu 
chỉnh màu) - theo mặc định là được 
bật. Nếu không chọn mục này, bạn 
không được phép hiệu chỉnh màu và 
tắt các nút khởi động và xem nhanh.

6. Phải có thông tin bằng sáng chế trên 
màn hình hiệu chỉnh.
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3. Tối ưu hóa hình ảnh
Màn hình hiệu chỉnh màu đầu tiên:

• Nút Previous (Trước) sẽ tắt cho đến 
khi màn hình màu thứ hai bật lên.

• Next (Kế tiếp) sẽ chuyển vào mục tiêu 
tiếp theo (6 mục tiêu).

• Kế tiếp cuối cùng sẽ vào giao diện 
File>Presets (File>Cài sẵn).

• Nút Cancel (Hủy) sẽ đóng giao diện 
người dùng (UI) và trở về trang Plug-
in (bổ sung).

SmartImage Lite
Cho phép người dùng thay đổi cài đặt để 
đạt mức cài đặt màn hình tốt hơn dựa vào 
nội dung.

Khi đã cài đặt Entertainment (Giải trí), tính 
năng SmartContrast và SmartResponse 
sẽ tắt.

Options>Preferences (Tùy chọn>Ưu tiên) 
- Sẽ chỉ hoạt động khi chọn Preferences 
(Ưu tiên) từ menu Options (Tùy chọn) sổ 
xuống. Trên màn hình không hỗ trợ tương 
thích với chuẩn DDC/CI, chỉ có sẵn các 
thẻ Help (Trợ giúp) và Options (Tùy chọn).

• Hiển thị các cài đặt ưu tiên hiện hành.
• Ô vừa chọn sẽ bật tính năng này. Ô 

chọn là nút bật/tắt.
• Enable Context Menu (Menu bật thuộc 

tính) trên màn hình nền PC sẽ được 
chọn là (Bật) theo mặc định. Menu 
Enable Context (Bật thuộc tính) hiển 
thị các lựa chọn SmartControl Lite cho 
Select Preset (Chọn cài sẵn) và Tune 
Display (Chỉnh màn hình) trong menu 
thuộc tính khi click phải vào màn 
hình nền. Disabled (Đã tắt) sẽ xóa 
SmartControl Lite khỏi menu thuộc 
tính click phải.

• Biểu tượng Enable Task Tray (Bật 
khay tác vụ) được chọn là (Bật) theo 
mặc định. Enable Context Menu 
(Menu bật thuộc tính) hiển thị menu 
khay tác vụ cho SmartControl Lite. 
Click phải vào biểu tượng khay tác 
vụ sẽ hiển thị các tùy chọn menu cho 
Help (Trợ giúp), Technical Support 
(Hỗ trợ kỹ thuật), Check for Update 
(Kiểm tra cập nhật), About (Về) và Exit 
(Thoát). Khi đã tắt Enable task tray 
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menu (Menu bật khay tác vụ), biểu 
tượng khay tác vụ sẽ chỉ hiển thị EXIT 
(THOÁT).

• Theo mặc định Run at Startup (Chạy 
khi khởi động) sẽ được chọn là (BẬT). 
Khi đã tắt, SmartControl Lite sẽ không 
bật khi khởi động hoặc nằm trong 
khay tác vụ. Cách duy nhất để bật 
SmartControl Lite là từ phím tắt trên 
màn hình nền hoặc từ file chương 
trình. Bất kỳ bộ cài đặt sẵn nào để 
chạy khi khởi động sẽ hoạt động 
không tải khi ô này không được chọn 
(Đã tắt).

• Enable transparency mode (Bật chế 
độ trong suốt) (Windows 7, Vista, XP). 
Mặc định là 0% Mờ.

Options>Input (Tùy chọn>Nhập) - Sẽ chỉ 
hoạt động khi chọn Input (Nhập) từ menu 
Options (Tùy chọn) sổ xuống. Trên màn 
hình không hỗ trợ tương thích với chuẩn 
DDC/CI, chỉ có sẵn các thẻ Help (Trợ 
giúp) và Options (Tùy chọn). Tất cả các 
thẻ SmartControl Lite khác đều không có 
sẵn.

• Hiển thị giao diện hướng dẫn Source 
(Nguồn) và cài đặt nguồn nhập thông 
tin hiện hành.

• Trên các màn hình nhập riêng, giao 
diện này sẽ không hiển thị.

Options>Audio (Tùy chọn>Âm thanh) 
- Sẽ chỉ hoạt động khi chọn Audio (Âm 
thanh) từ menu Options (Tùy chọn) sổ 
xuống.

Trên màn hình không hỗ trợ tương thích 
với chuẩn DDC/CI, chỉ có sẵn các thẻ Help 
(Trợ giúp) và Options (Tùy chọn).

Help>User Manual (Trợ giúp>Sổ tay sử 
dụng) - Sẽ chỉ hoạt động khi chọn User 
Manual (Sổ tay sử dụng) từ menu Help 
(Trợ giúp) sổ xuống. Trên màn hình không 
hỗ trợ tương thích với chuẩn DDC/CI, chỉ 
có sẵn các thẻ Help (Trợ giúp) và Options 
(Tùy chọn).
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Help>Version (Trợ giúp>Phiên bản) - 
Sẽ chỉ hoạt động khi chọn Version (Phiên 
bản) từ menu Help (Trợ giúp) sổ xuống. 
Trên màn hình không hỗ trợ tương thích 
với chuẩn DDC/CI, chỉ có sẵn các thẻ Help 
(Trợ giúp) và Options (Tùy chọn).

Context Sensitive menu  
(Menu nhạy cảm với thuộc tính)
Theo mặc định, menu Context Sensitive 
(Chỉnh theo thuộc tính) sẽ được Bật. Nếu 
đã chọn menu Enable Context (Bật thuộc 
tính) trong giao diện Options>Preferences 
(Tùy chọn>Ưu tiên) thì menu này sẽ hiển 
thị.

The Context Menu (Menu thuộc tính) có 
bốn mục nhập:
• SmartControl Lite - khi đã chọn, About 

Screen (Về màn hình) sẽ hiển thị.
• Select Preset (Chọn cài đặt sẵn) - 

Cung cấp menu các mục cài sẵn đã 
lưu theo trình tự để sử dụng ngay. 
Dấu kiểm sẽ hiển thị mục cài sẵn hiện 

đã chọn. Mục Factory Preset (Cài sẵn 
gốc) cũng có thể được chọn từ menu 
sổ xuống.

• Tune Display (Chỉnh màn mình) - Mở 
bảng điều khiển SmartControl Lite.

• SmartImage Lite - Kiểm tra các cài đặt 
hiện hành, Standard (Chuẩn), Internet, 
Game.

Đã bật menu khay tác vụ
Bạn có thể hiển thị menu khay tác vụ 
bằng cách click phải vào biểu tượng 
SmartControl Lite từ khay tác vụ. Click trái 
sẽ bật ứng dụng.

Khay tác vụ có năm mục nhập:
• Help (Trợ giúp) - Truy cập file User 

Manual (Sổ tay sử dụng): Mở file User 
Manual (Sổ tay sử dụng) qua cửa sổ 
trình duyệt mặc định.

• Technical Support (Hỗ trợ kỹ thuật) - 
hiển thị trang hỗ trợ kỹ thuật.

• Check for Update (Kiểm tra cập nhật) 
- dẫn người dùng đến Nền ứng dụng 
PDI và kiểm tra phiên bản của người 
dùng so với phiên bản có sẵn mới 
nhất.

• About (Về) - Hiển thị thông tin tham 
khảo chi tiết: phiên bản sản phẩm, 
thông tin về phiên bản và tên sản 
phẩm.

• Exit (Thoát) - Đóng SmartControl Lite.
Để chạy lại SmartControl Lite, hãy chọn 
SmartControl Lite từ menu Program 
(Chương trình), click đôi biểu tượng PC 
trên màn hình nền hoặc khởi động lại hệ 
thống.
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Đã tắt menu khay tác vụ
Khi đã tắt Khay tác vụ trong thư mục 
ưu tiên, chỉ còn có sẵn lựa chọn EXIT 
(THOÁT). Để xóa hoàn toàn SmartControl 
Lite khỏi khay tác vụ, hãy tắt Run at 
Startup (Chạy khi khởi động) trong 
Options>Preferences (Tùy chọn>Ưu tiên).

 Lưu ý

Tất cả các hình minh họa trong phần 
này chỉ được dùng để tham khảo. Chúng 
tôi có thể thay đổi phiên bản phần mềm 
SmartControl mà không cần thông báo 
trước. Vui lòng luôn truy cập trang web 
chính thức của Portrait tại www.portrait.
com/dtune/phl/enu/index để tải về phiên 
bản phần mềm SmartControl mới nhất.
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4. Các thông số kỹ thuật
Hình ảnh/Màn hình
Loại mặt màn hình Màn hình LCD IPS
Đèn nền LED
Cỡ màn hình Rộng 21,5 inch (54,6cm)
Hệ số co 16:9
Độ pixel 0,2479 x 0,2479 mm
Độ sáng 250 cd/m²
SmartContrast 20.000.000:1
Độ tương phản (chuẩn) 1000:1
Thời gian đáp ứng (chuẩn) 14 ms (mili giây)
Phản ứng thông minh 
SmartResponse (chỉ có sẵn 
cho các mẫu đã chọn)

5 ms (mili giây)

Độ phân giải tối ưu 1920x1080 @ 60Hz
Góc xem 178° (H) / 178° (V) @ C/R > 10
Cải tiến hình ảnh SmartImage Lite
Màu màn hình 16,7 triệu màu
Tốc độ phát dọc 56Hz - 76Hz
Tần số ngang 30kHz - 83kHz
MHL 1080P@30Hz
sRGB (Đỏ-Lục-Lam chuẩn) CÓ
Kết nối

Đầu vào tín hiệu

224E5QSB, 224E5QSW: VGA (Analog), DVI (KTS 
,HDCP)
224E5QHAB, 224E5QHAW, 224E5QHSB: VGA (Analog), 
HDMI (KTS ,HDCP), MHL-HDMI (KTS ,HDCP)
224E5QDAB: VGA (Analog), DVI (KTS ,HDCP), MHL-
HDMI (KTS ,HDCP)

Đầu ra/vào âm thanh
224E5QHAB, 224E5QHAW, 224E5QDAB : Đầu vào âm 
thanh PC, đầu ra tai nghe
224E5QHSB : Đầu ra âm thanh HDMI

Tín hiệu vào Đồng bộ riêng, Đồng bộ với tín hiệu xanh lục

Tiện ích

Tiện ích cho người dùng

224E5QSB, 224E5QSW, 224E5QHSB:

224E5QHAB, 224E5QHAW, 224E5QDAB:
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Ngôn ngữ OSD (Hiển thị 
trên màn hình)

Tiếng Anh, Tiếng Đức, Tiếng Tây Ban Nha, Tiếng Hy Lạp, 
Tiếng Pháp, Tiếng Ý, Tiếng Hungary, Tiếng Hà Lan, Tiếng 
Bồ Đào Nha, Tiếng Bồ Đào Nha Brazil, Tiếng Ba Lan, 
Tiếng Nga, Tiếng Thụy Điển, Tiếng Phần Lan, Tiếng Thổ 
Nhĩ Kỳ, Tiếng Séc, Tiếng Ukrana, Tiếng Hoa giản thể, 
Tiếng Hoa phồn thể, Tiếng Nhật, Tiếng Hàn

Tiện ích khác Khóa Kensington
Tương thích với chuẩn Plug 
& Play (Cắm vào là phát) DDC/CI, sRGB, Windows 8/7/Vista/XP, Mac OSX, Linux

Đế giữ
Nghiêng -5° / +20°

224E5QSB, 224E5QSW:
Nguồn điện
Chế độ bật 25,2 W (chuẩn)
Chế độ chờ (chuẩn) 0,5W
Tắt (chuẩn) 0,3W
Đèn báo LED nguồn Chế độ bật: Chế độ Trắng, Chờ/Ngủ: Trắng (nhấp nháy)
Bộ nguồn Ngoại vi, 100-240VAC, 50-60Hz

224E5QHSB :
Nguồn điện
Chế độ bật 26,5 W (chuẩn)
Chế độ chờ (chuẩn) 0,5W
Tắt (chuẩn) 0,3W
Đèn báo LED nguồn Chế độ bật: Chế độ Trắng, Chờ/Ngủ: Trắng (nhấp nháy)
Bộ nguồn Ngoại vi, 100-240VAC, 50-60Hz

224E5QHAB, 224E5QHAW :
Nguồn điện
Chế độ bật 26,5 W (chuẩn), 39,5 W (tối đa)
Chế độ chờ (chuẩn) 0,5W
Tắt (chuẩn) 0,3W
Đèn báo LED nguồn Chế độ bật: Chế độ Trắng, Chờ/Ngủ: Trắng (nhấp nháy)
Bộ nguồn Ngoại vi, 100-240VAC, 50-60Hz

224E5QDAB :
Nguồn điện
Chế độ bật 21,59 W (chuẩn), 34,0 W (tối đa)
Chế độ chờ (chuẩn) 0,5W
Tắt (chuẩn) 0,3W
Đèn báo LED nguồn Chế độ bật: Chế độ Trắng, Chờ/Ngủ: Trắng (nhấp nháy)
Bộ nguồn Ngoại vi, 100-240VAC, 50-60Hz
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Kích thước
Sản phẩm kèm theo đế giữ 
(Rộng x cao x dày) 500 x 394 x 213 mm

Sản phẩm không kèm theo 
đế giữ (Rộng x cao x dày) 500 x 306 x 47 mm

Trọng lượng
Sản phẩm kèm theo đế giữ 3,14 kg
Sản phẩm không kèm theo 
đế giữ 2,82 kg

Sản phẩm đóng gói 5,01 kg

Điều kiện hoạt động
Phạm vi nhiệt độ (hoạt động) 0°C - 40 °C
Giới hạn nhiệt độ
(Không hoạt động) -20°C - 60°C

Độ ẩm tương đối 20% - 80%
MTBF (Thời lượng trung 
bình giữa các sự cố) 30.000 giờ

Môi trường
Chỉ thị ROHS (Giới hạn các 
chất gây hại) CÓ

EPEAT Bạc (www.epeat.net)
Thùng đựng Có thể tái chế 100%
Các chất cụ thể Thùng đựng 100% không chứa PVC BFR
Ngôi sao năng lượng CÓ
Tuân thủ và tiêu chuẩn

Phê chuẩn theo quy định CE Mark, FCC Class B, CU, SEMKO, TCO Certified, 
ETL, BSMI, ISO9241-307

Vỏ ngoài

Màu

224E5QSW, 224E5QHAW: Trắng/224E5QSB, 
224E5QHSB, 224E5QHAB, 224E5QDAB: Màu đen/Màu 
đỏ anh đào hoặc các tùy chọn màu khác như áp dụng tại 
khu vực của bạn

Lớp sơn ngoài Bóng láng

 Ghi chú
1. Vàng hay bạc EPEAT chỉ có hiệu lực tại nơi mà Philips đã đăng ký sản phẩm. Hăy truy 

cập www.epeat.net để biết t́nh trạng đăng kư tại quốc gia của bạn.
2. Dữ liệu này chịu sự thay đổi mà không cần thông báo trước. Truy cập www.philips.com/

support để tải về phiên bản tờ rơi mới nhất.
3. Thời gian phản ứng thông minh là giá trị tối ưu từ các thử nghiệm GtG hoặc GTG (BW).
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4.1 Chế độ độ phân giải & cài 
đặt sẵn

 Độ phân giải tối đa
1920x1080@60 Hz (đầu vào analog)
1920x1080@60 Hz (đầu vào KTS)

 Độ phân giải khuyên dùng
1920x1080@60 Hz (đầu vào KTS)

Tần số 
ngang (kHz)

Độ phân giải Tần số dọc 
(Hz)

31,47 720 x 400 70,09
31,47 640 x 480 59,94
35,00 640 x 480 66,67
37,86 640 x 480 72,81
37,50 640 x 480 75,00
37,88 800 x 600 60,32
46,88 800 x 600 75,00
48,36 1024 x 768 60,00
60,02 1024 x 768 75,03
63,89 1280 x 1024 60,02
79,98 1280 x 1024 75,03
55,94 1440 x 900 59,89
70,64 1440 x 900 74,98
65,29 1680 x 1050 59,95
67,50 1920 x 1080 60,00

 Ghi chú
Lưu ý rằng màn hình của bạn hoạt 
động tốt nhất ở độ phân giải gốc 
1920×1080@60Hz. Để có chất lượng hiển 
thị tốt nhất, hãy dùng độ phân giải khuyến 
nghị này.



24

5. Quản lý nguồn điện

5. Quản lý nguồn điện
Nếu bạn đã cài đặt card màn hình hay 
phần mềm tương thích chuẩn VESA DPM 
vào PC, màn hình có thể tự động giảm 
tiêu thụ điện khi không sử dụng. Nếu phát 
hiện nhập từ bàn phím, chuột hay thiết bị 
nhập khác, màn hình sẽ "hoạt động" tự 
động. Bảng sau đây sẽ hiển thị mức tiêu 
thụ điện và cách truyền tín hiệu của tính 
năng tiết kiệm điện tự động này:

224E5QSB, 224E5QSW:
Định nghĩa quản lý nguồn điện

Chế độ 
VESA Video

Đồng 
bộ 

ngang

Đồng 
bộ dọc

Nguồn điện sử 
dụng

Màu đèn 
LED 

Hoạt động BẬT Có Có 25,2 W (chuẩn) Trắng

Ngủ TẮT Không Không 0,5 W (chuẩn)
Trắng 
(Nhấp 
nháy)

Tắt TẮT - - 0,3 W (chuẩn) TẮT

224E5QHSB:
Định nghĩa quản lý nguồn điện

Chế độ 
VESA Video

Đồng 
bộ 

ngang

Đồng 
bộ dọc

Nguồn điện sử 
dụng

Màu đèn 
LED 

Hoạt động BẬT Có Có 26,5 W (chuẩn) Trắng

Ngủ TẮT Không Không 0,5 W (chuẩn)
Trắng 
(Nhấp 
nháy)

Tắt TẮT - - 0,3 W (chuẩn) TẮT

224E5QHAB, 224E5QHAW:
Định nghĩa quản lý nguồn điện

Chế độ 
VESA Video

Đồng 
bộ 

ngang

Đồng 
bộ dọc

Nguồn điện sử 
dụng

Màu đèn 
LED 

Hoạt động BẬT Có Có 26,5 W (chuẩn)
39,5 W (tối đa) Trắng

Ngủ TẮT Không Không 0,5 W (chuẩn)
Trắng 
(Nhấp 
nháy)

Tắt TẮT - - 0,3 W (chuẩn) TẮT

224E5QDAB:

Định nghĩa quản lý nguồn điện

Chế độ 
VESA Video

Đồng 
bộ 

ngang

Đồng 
bộ dọc

Nguồn điện sử 
dụng

Màu đèn 
LED 

Hoạt động BẬT Có Có
21,59 W 
(chuẩn)

34,0 W (tối đa)
Trắng

Ngủ TẮT Không Không 0,5 W (chuẩn)
Trắng 
(Nhấp 
nháy)

Tắt TẮT - - 0,3 W (chuẩn) TẮT

Cài đặt sau đây được dùng để đo mức 
tiêu thụ điện trên màn hình.

• Độ phân giải gốc: 1920x1080
• Độ tương phản: 50%
• Độ sáng: 250 nit
• Nhiệt độ màu: 6500k với kiểu màu 

trắng đầy đủ

 Ghi chú
Dữ liệu này chịu sự thay đổi mà không 
cần thông báo trước.
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Lead-free Product

Lead free display promotes 
environmentally sound recovery 
and disposal of waste from electrical 
and electronic equipment. Toxic 

substances like Lead has been eliminated 
and compliance with European community’s 
stringent RoHs directive mandating restrictions 
on hazardous substances in electrical and 
electronic equipment have been adhered to 
in order to make Philips monitors safe to use 
throughout its life cycle.

Congratulations!

This product is designed for both you and the 
planet! 

TCO Development works for 
sustainable IT - manufacture, 
use and recycling of IT products 

reflecting environmental, social and economic 
responsibility. 

TCO Certified is a third party verified program, 
where every product model is tested by an 
accredited impartial test laboratory. TCO 
Certified represents one of the toughest 
certifications for ICT products worldwide. 

Some of the Usability features of TCO 
Certified Displays: 

•	 Visual Ergonomics for image quality 
is tested to ensure top performance 
and reduce sight and strain problems. 
Important parameters are Resolution, 
Luminance, Contrast, Reflection and Colour 
characteristics

•	 Products are tested according to rigorous 
safety standards at impartial laboratories 

•	 Electric and magnetic fields emissions as 
low as normal household background levels

•	 Workload ergonomics to ensure a good 
physical environment  

Some of the Environmental features of TCO 
Certified Displays:  

•	 Production facilities have an Environmental 
Management System (EMAS or ISO 14001) 

•	 Low energy consumption to minimize 
climate impact  

•	 Restrictions on Chlorinated and 
Brominated flame retardants, plasticizers, 
plastics and heavy metals such as cadmium, 
mercury and lead (RoHS compliance) 

•	 Both product and product packaging is 
prepared for recycling

•	 The brand owner offers take-back options 

Corporate Social Responsibility 

•	 The brand owner demonstrates the 
product is manufactured under working 
practices that promote good labour 
relations and working conditions.  

The Criteria Document can be downloaded 
from our web site. The criteria included in 
this label have been developed by TCO 
Development in co-operation with scientists, 
experts, users as well as manufacturers all 
over the world. Since the end of the 1980s 
TCO has been involved in influencing the 
development of IT equipment in a more user 
and environmentally friendly direction. Our ICT 
product labeling system began in 1992 and is 
now requested by users and ICT-manufacturers 
all over the world.  

For displays with glossy bezels, the user should 
consider the placement of the display as the 
bezel may cause disturbing reflections from 
surrounding light and bright surfaces.

For more information, please visit:  
www.tcodevelopment.com

Technology for you and the planet

(Only for selective models)
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EPEAT

(www.epeat.net)

The EPEAT (Electronic 
Product Environmental 
Assessment Tool) program 
evaluates computer 

desktops, laptops, and monitors based on 51 
environmental criteria developed through 
an extensive stakeholder consensus process 
supported by US EPA.

EPEAT system helps purchasers in the public 
and private sectors evaluate, compare and 
select desktop computers, notebooks and 
monitors based on their environmental 
attributes. EPEAT also provides a clear and 
consistent set of performance criteria for the 
design of products, and provides an opportunity 
for manufacturers to secure market recognition 
for efforts to reduce the environmental impact 
of its products.

Benefits of EPEAT

Reduce use of primary materials 
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S 
requirement that all registered products meet 
ENERGY STAR’s energy efficiency specifications, 
means that these products will consume less 
energy throughout their life.

CE Declaration of Conformity

This product is in conformity with the following 
standards 

•	 EN60950-1:2006+A11:2009+A1: 
2010+A12:2011 (Safety requirement of 
Information Technology Equipment).

•	 EN55022:2010(Radio Disturbance 
requirement of Information Technology 
Equipment).

•	 EN55024:2010 (Immunity requirement of 
Information Technology Equipment).

•	 EN61000-3-2:2006+A1:2009+A2:2009 
(Limits for Harmonic Current Emission).

•	 EN61000-3-3:2008 (Limitation of Voltage 
Fluctuation and Flicker) following provisions 
of directives applicable.

•	 2006/95/EC (Low Voltage Directive).

•	 2004/108/EC (EMC Directive).

•	 2009/125/EC (ErP Directive, EC No. 
1275/2008 Implementing Directive 
for Standby and Off mode power 
consumption)

And is produced by a manufacturing 
organization on ISO9000 level.

•	 ISO9241-307:2008 (Ergonomic 
requirement, Analysis and compliance test 
methods for electronic visual displays).

•	 GS EK1-2000:2011 (GS mark requirement).

•	 prEN50279:1998 (Low Frequency Electric 
and Magnetic fields for Visual Display).

•	 MPR-II (MPR:1990:8/1990:10 Low 
Frequency Electric and Magnetic fields).

•	 TCO CERTIFIED (Requirement for 
Environment Labeling of Ergonomics, 
Energy, Ecology and Emission, TCO: Swedish 
Confederation of Professional Employees) 
for TCO versions.



27

6. Thông tin quy định
Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner, we 
have determined that this product 
meets the ENERGY STAR® 
guidelines for energy efficiency.

 Note
We recommend you switch off the monitor 
when it is not in use for a long time.

Federal Communications Commission (FCC) 
Notice (U.S. Only)

 This equipment has been tested and found 
to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide 
reasonable protection against harmful 
interference in a residential installation. 
This equipment generates, uses and can 
radiate radio frequency energy and, if not 
installed and used in accordance with the 
instructions, may cause harmful interference 
to radio communications.  
 
However, there is no guarantee that 
interference will not occur in a particular 
installation. If this equipment does cause 
harmful interference to radio or television 
reception, which can be determined by 
turning the equipment off and on, the 
user is encouraged to try to correct 
the interference by one or more of the 
following measures: 

•	 Reorient or relocate the receiving antenna.

•	 Increase the separation between the 
equipment and receiver.

•	 Connect the equipment into an outlet on 
a circuit different from that to which the 
receiver is connected.

•	 Consult the dealer or an experienced 
radio/TV technician for help.

 Changes or modifications not expressly 
approved by the party responsible for 
compliance could void the user's authority 
to operate the equipment.

Use only RF shielded cable that was supplied 
with the monitor when connecting this monitor 
to a computer device. 

To prevent damage which may result in fire or 
shock hazard, do not expose this appliance to 
rain or excessive moisture. 

THIS CLASS B DIGITAL APPARATUS MEETS 
ALL REQUIREMENTS OF THE CANADIAN 
INTERFERENCE-CAUSING EQUIPMENT 
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked 
with FCC Logo, 

United States Only

This device complies with Part 15 of the FCC 
Rules. Operation is subject to the following two 
conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any 
interference received, including interference that 
may cause undesired operation. 

Commission Federale de la Communication 
(FCC Declaration)

 Cet équipement a été testé et déclaré 
conforme auxlimites des appareils 
numériques de class B,aux termes de 
l'article 15 Des règles de la FCC. Ces 
limites sont conçues de façon à fourir 
une  protection raisonnable contre les 
interférences nuisibles dans le cadre d'une 
installation résidentielle.  
 
CET appareil produit, utilise et peut émettre 
des hyperfréquences qui, si l'appareil n'est 
pas installé et utilisé selon les consignes 
données, peuvent causer des interférences 
nuisibles aux communications radio.  
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Cependant, rien ne peut garantir l'absence 
d'interférences dans le cadre d'une 
installation particulière. Si cet appareil est 
la cause d'interférences nuisibles pour 
la réception des signaux de radio ou de 
télévision, ce qui peut être décelé en 
fermant l'équipement, puis en le remettant 
en fonction, l'utilisateur pourrait essayer de 
corriger la situation en prenant les mesures 
suivantes:

•	 Réorienter ou déplacer l’antenne de 
réception.

•	 Augmenter la distance entre l’équipement 
et le récepteur.

•	 Brancher l’équipement sur un autre circuit 
que celui utilisé par le récepteur.

•	 Demander l’aide du marchand ou d’un 
technicien chevronné en radio/télévision.

 Toutes modifications n'ayant pas reçu 
l'approbation des services compétents 
en matière de conformité est susceptible 
d'interdire à l'utilisateur l'usage du présent 
équipement.

N'utiliser que des câbles RF armés pour 
les connections avec des ordinateurs ou 
périphériques. 

CET APPAREIL NUMERIQUE DE LA CLASSE 
B RESPECTE TOUTES LES EXIGENCES DU 
REGLEMENT SUR LE MATERIEL BROUILLEUR 
DU CANADA. 

EN 55022 Compliance (Czech Republic Only)

Polish Center for Testing and Certification 
Notice

The equipment should draw power from a 
socket with an attached protection circuit (a 
three-prong socket). All equipment that works 
together (computer, monitor, printer, and so on) 
should have the same power supply source.

The phasing conductor of the room's electrical 
installation should have a reserve short-circuit 
protection device in the form of a fuse with a 
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the 
power supply cable must be removed from the 
power supply socket, which should be located 
near the equipment and easily accessible.

A protection mark "B" confirms that the 
equipment is in compliance with the protection 
usage requirements of standards PN-93/T-42107 
and PN-89/E-06251.
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Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht 
den in der "Verordnung über den Schutz vor 
Schäden durch Röntgenstrahlen" festgelegten 
Vorschriften. 

Auf der Rückwand des Gerätes befindet sich 
ein Aufkleber, der auf die Unbedenklichkeit der 
Inbetriebnahme hinweist, da die Vorschriften 
über die Bauart von Störstrahlern nach Anlage 
III	¤	5	Abs.	4	der	Röntgenverordnung	erfüllt	sind.	

Damit Ihr Monitor immer den in der Zulassung 
geforderten Werten entspricht, ist darauf zu 
achten, daß 

1. Reparaturen nur durch Fachpersonal 
durchgeführt werden. 

2.  nur original-Ersatzteile verwendet werden. 

3.  bei Ersatz der Bildröhre nur eine 
bauartgleiche eingebaut wird. 

Aus ergonomischen Gründen wird empfohlen, 
die Grundfarben Blau und Rot nicht auf 
dunklem Untergrund zu verwenden (schlechte 
Lesbarkeit und erhöhte Augenbelastung bei zu 
geringem Zeichenkontrast wären die Folge). 
Der arbeitsplatzbezogene Schalldruckpegel 
nach DIN 45 635 beträgt 70dB (A) oder 
weniger. 

 ACHTUNG: BEIM AUFSTELLEN 
DIESES GERÄTES DARAUF 
ACHTEN, DAß NETZSTECKER UND 
NETZKABELANSCHLUß LEICHT 
ZUGÄNGLICH SIND. 

North Europe (Nordic Countries) Information

Placering/Ventilation 
VARNING:
FÖRSÄKRA DIG OM ATT HUVUDBRYTARE 
OCH UTTAG ÄR LÄTÅTKOMLIGA, NÄR 
DU STÄLLER DIN UTRUSTNING PÅPLATS.

Placering/Ventilation 
ADVARSEL: 
SØRG VED PLACER INGEN FOR , AT 
NETLEDNINGENS STIK OG STIKKONTAKT 
ER NEMT TILGÆNGELIGE. 

Paikka/Ilmankierto 
VAROITUS: 
SIJOITA LAITE SITEN, ETTÄ VERKKOJOHTO 
VOIDAAN TARVITTAESSA HELPOSTI 
IRROTTAA PISTORASIASTA. 

Plassering/Ventilasjon 
ADVARSEL: 
NÅR DETTE UTSTYRET PLASSERES, MÅ 
DU PASSE PÅ AT KONTAKTENE FOR 
STØMTILFØRSEL ER LETTE Å NÅ.

BSMI Notice (Taiwan Only)
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China RoHS 

The People's Republic of China released a 
regulation called "Management Methods for 
Controlling Pollution by Electronic Information 
Products" or commonly referred to as China 
RoHS. All products including CRT and Monitor 
which are produced and sold for China market 
have to meet China RoHS request.

 环保使用期限 

此标识指期限(十年),电子信息产品中含有的有毒
有害物质或元素在正常使用的条件下不会发生外
泄或突变, 电子信息产品用户使用该电子信息产
品不会对环境造成严重污染或对其人身、 财产造
成严重损害的期限．

《废弃电器电子产品回收处理管理条例》提示性
说明

为了更好地关爱及保护地球，当用户不再需要此
产品或产品寿命终止时，请遵守国家废弃电器电
子产品回收处理相关法律法规，将其交给当地具
有国家认可的回收处理资质的厂商进行回收处

理。

EU Energy Label

The European Energy Label informs you on 
the energy efficiency class of this product. 
The greener the energy efficiency class of this 
product is the lower the energy it consumes. On 
the label, you can find the energy efficiency class, 
the average power consumption of this product 
in use and the average energy consumption for 
1 year. 

Note

The EU Energy Label will be ONLY applied on 
the models bundling with HDMI and TV tuners.
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7. Dịch vụ chăm sóc 
khách hàng và bảo 
hành

7.1 Chính sách lỗi điểm ảnh màn 
hình phẳng của Philips

Philips cố gắng cung cấp các sản phẩm 
chất lượng cao nhất. Chúng tôi áp dụng 
một số quy trình sản xuất tiên tiến nhất 
trong lĩnh vực và thực hiện quy trình kiểm 
tra chất lượng nghiêm ngặt. Tuy nhiên, 
các lỗi điểm ảnh hay điểm ảnh con trên 
màn hình TFT dùng trong các màn hình 
phẳng đôi khi không thể tránh khỏi. Không 
nhà sản xuất nào có thể đảm bảo rằng 
mọi màn hình sẽ không có các lỗi điểm 
ảnh, nhưng Philips đảm bảo rằng bất kỳ 
màn hình nào có một số lỗi không thể 
chấp nhận sẽ được sửa chữa hoặc thay 
mới dựa vào chính sách bảo hành. Thông 
báo này giải thích những kiểu lỗi điểm ảnh 
khác nhau và định nghĩa các mức lỗi có 
thể chấp nhận cho mỗi kiểu lỗi. Để hưởng 
dịch vụ sửa chữa hay thay thế theo chính 
sách bảo hành, số lượng lỗi điểm ảnh trên 
màn hình TFT phải vượt quá các mức 
chấp nhận này. Ví dụ, không quá 0,0004% 
điểm ảnh con trên màn hình có thể bị lỗi. 
Ngoài ra, Philips thậm còn đặt ra các tiêu 
chuẩn chất lượng cao hơn cho một số 
kiểu hay kết hợp lỗi điểm ảnh vốn dễ nhìn 
thấy hơn các kiểu lỗi khác. Chính sách 
này có hiệu lực trên toàn cầu.

điểm ảnh con

Điểm
ảnh

Điểm ảnh và điểm ảnh con
Điểm ảnh hay phần tử ảnh gồm ba điểm 
ảnh con trong các màu chính đỏ, lục và 
lam. Nhiều điểm ảnh cùng tạo thành hình 
ảnh. Khi mọi điểm ảnh con của một điểm 
ảnh sáng lên, ba điểm ảnh con có màu 
sắc cùng hiển thị như một điểm ảnh trắng 
đơn lẻ. Khi mọi điểm ảnh con tối mờ, ba 

điểm ảnh con có màu sắc cùng hiển thị 
như một điểm ảnh đen đơn lẻ. Những kết 
hợp điểm ảnh con sáng và tối khác hiển 
thị như các điểm ảnh đơn lẻ từ những 
màu khác.

Các kiểu lỗi điểm ảnh
Các lỗi điểm ảnh và điểm ảnh con hiển 
thị trên màn hình theo những cách khác 
nhau. Có hai kiểu lỗi điểm ảnh và nhiều lỗi 
điểm ảnh con trong mỗi kiểu lỗi.

Các lỗi chấm sáng
Các lỗi chấm sáng hiển thị dưới dạng các 
điểm ảnh hay điểm ảnh con vốn luôn sáng 
hay "bật". Nghĩa là mỗi chấm sáng là một 
điểm ảnh con vốn nổi lên trên màn hình 
khi màn hình hiển thị kiểu hình tối mờ. Có 
các kiểu lỗi chấm sáng.

Một điểm ảnh con sáng đỏ, lục hay lam.

Hai điểm ảnh con sáng gần nhau:
- Đỏ + Lam = Tím
- Đỏ + Lục = Vàng
- Lục + Lam = Lục lam (Lam nhạt)

Ba điểm ảnh con sáng gần nhau (một 
điểm ảnh trắng).
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 Ghi chú

Chấm sáng đỏ hay lam phải sáng hơn 
50% so với các chấm xung quanh trong 
khi chấm sáng lục sáng hơn 30% so với 
các chấm xung quanh.

Các lỗi chấm đen
Các lỗi chấm đen hiển thị dưới dạng các 
điểm ảnh hay điểm ảnh con vốn luôn tối 
mờ hay 'tắt'. Nghĩa là mỗi chấm tối mờ là 
một điểm ảnh con vốn nổi lên trên màn 
hình khi màn hình hiển thị kiểu hình sáng. 
Có các kiểu lỗi chấm đen.

LỖI CHẤM SÁNG MỨC CHẤP NHẬN
1 điểm ảnh con sáng 3
2 điểm ảnh con sáng gần nhau 1
3 điểm ảnh con sáng gần nhau (một điểm ảnh trắng) 0
Khoảng cách giữa hai lỗi chấm sáng* >15mm
Tổng số lỗi chấm sáng của mọi kiểu lỗi 3
LỖI CHẤM ĐEN MỨC CHẤP NHẬN
1 điểm ảnh con tối mờ 5 hoặc ít hơn
2 điểm ảnh con tối mờ gần nhau 2 hoặc ít hơn
3 điểm ảnh con tối mờ gần nhau 0
Khoảng cách giữa hai lỗi chấm đen* >15mm
Tổng số lỗi chấm đen của mọi kiểu lỗi 5 hoặc ít hơn
TỔNG SỐ LỖI CHẤM MỨC CHẤP NHẬN
Tổng số lỗi chấm sáng hay đen của mọi kiểu lỗi 5 hoặc ít hơn

 Ghi chú
1. 1 hay 2 lỗi điểm ảnh con gần nhau = 1 lỗi chấm
2. Màn hình này tuân thủ chuẩn ISO 9241-307. (ISO9241-307: Yêu cầu, phân tích về hiệu 

năng và các phương pháp kiểm tra tuân thủ cho màn hình điện tử)

Độ gần của các lỗi điểm ảnh
Vì các lỗi điểm ảnh và điểm ảnh con của 
cùng kiểu lỗi vốn gần với một kiểu lỗi khác 
có thể dễ nhìn thấy hơn, Philips cũng nêu 
rõ các dung sai về độ gần của lỗi điểm 
ảnh.

Dung sai lỗi điểm ảnh
Để hưởng dịch vụ sửa chữa hay thay 
thế do các lỗi điểm ảnh trong thời hạn 
bảo hành, màn hình TFT trong màn hình 
phẳng Philips phải có các lỗi điểm ảnh hay 
điểm ảnh con vượt quá những dung sai 
nêu trong các bảng sau.
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7.2 Chăm sóc khách hàng & Chế độ bảo hành
Để có thông tin chi tiết về chính sách bảo hành và yêu cầu hỗ trợ thêm được áp dụng cho 
khu vực của bạn, vui lòng truy cập website www.philips.com/support. Bạn cũng có thể liên 
hệ với Trung tâm chăm sóc khách hàng địa phương của Philips theo số điện thoại dưới 
đây.

Thông tin liên lạc cho khu vực TÂY ÂU:
Quốc gia ASC (Trung tâm dịch 

vụ ủy quyền)
Số chăm sóc khách hàng Giá

Germany Siemens I&S +49 01803 386 853 € 0,09
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Spain Eatsa Spain +34 902 888 785 € 0,10
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 € 0,09
Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 € 0,08
Netherlands E Care +31 0900 0400 063 € 0,10
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens I&S +43 0810 000206 € 0,07
Belgium E Care +32 078 250851 € 0,06
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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Thông tin liên lạc cho khu vực TRUNG VÀ ĐÔNG ÂU:

Quốc gia
Trung tâm 
dịch vụ

ASC (Trung tâm dịch vụ ủy 
quyền) Số chăm sóc khách hàng

Belarus NA IBA +375 17 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV” Ltd. +371 7460399
Lithuania NA UAB “Servicenet” +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
Serbia & 
Montenegro NA Kim Tec d.o.o. +381 11 20 70 684

Slovenia NA PC H.and +386 1 530 08 24

Ukraine
NA Comel +380 562320045
NA Topaz-Service Company +38 044 245 73 31

Russia
NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)

Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697

Hungary
NA Serware +36 1 2426331
NA Profi Service +36 1 814 8080

Thông tin liên lạc cho khu vực CHÂU MỸ LATINH:
Quốc gia Trung tâm dịch vụ Số chăm sóc khách hàng
Brazil

Vermont
0800-7254101

Argentina 0800 3330 856

Thông tin liên lạc ở Trung Quốc:
Trung Quốc
Số chăm sóc khách hàng: 4008 800 008

Thông tin liên lạc cho khu vực NAM MỸ:

Quốc gia Trung tâm dịch vụ ASC (Trung tâm dịch vụ 
ủy quyền) Số chăm sóc khách hàng

U.S.A. EPI - e-center Qwantech (877) 835-1838

Canada Supercom Supercom (800) 479-6696
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Thông tin liên lạc cho khu vực Châu Á TBD/Trung Đông/Châu Phi (APMEA):

Quốc gia Trung tâm 
dịch vụ

ASC (Trung tâm dịch vụ ủy 
quyền)

Số chăm sóc 
khách hàng

Australia NA AGOS NETWORK PTY LTD 1300 360 386

New Zealand NA Visual Group Ltd. 0800 657447

Hong Kong / Macau NA Smart Pixels Technology Ltd.
Hong Kong:Tel: +852 
2619 9639
Macau:Tel: (853)-
0800-987

India NA REDINGTON INDIA LTD
Tel: 1 800 425 6396
SMS: PHILIPS to 
56677

Indonesia NA PT. Gadingsari elektronika Prima Tel: 62 21 75909053, 
75909056, 7511530

South Korea NA Alphascan Displays, Inc. 1661-5003

Malaysia NA After Market Solutions (CE) Sdn 
Bhd 603 7953 3370

Pakistan NA Philips Consumer Service (9221) 2737411-16

Singapore NA
Philips Electronics Singapore 
Pte Ltd (Philips Consumer Care 
Center)

(65) 6882 3999

Taiwan
PCCW 
Teleservices 
Taiwan 

FETEC.CO 0800-231-099

Thailand NA Axis Computer System Co., Ltd. (662) 934-5498

South Africa NA Sylvara Technologies Pty Ltd 086 0000 888

United Arab 
Emirates NA AL SHAHD COMPUTER L.L.C 00971 4 2276525

Israel NA Eastronics LTD 1-800-567000

Vietnam NA FPT Service Informatic Company 
Ltd.

+84 8 38248007 Ho 
Chi Minh City
+84 5113.562666 
Danang City
+84 5113.562666 
Can tho Province

Philippines NA Glee Electronics, Inc. (02) 633-4533 to 34,
(02) 637-6559 to 60

Sri Lanka NA no distributor and/or service 
provider currently

Bangladesh NA Distributor: Computer Source Ltd 
(warranty buy-out)

880-2-9141747, 
9127592
880-2-8128848 / 52

Nepal NA Distributor: Syakar Co. Ltd 
(warranty buy-out) 977-1-4222395

Cambodia NA Distributor: Neat Technology Pte 
Ltd (Singapore) (warranty buy-out) 855-023-999992

Japan N/A フィリップスモニター・サポ ート
センター

0120-060-530
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8. Khắc phục sự cố & 
Hỏi Đáp

8.1 Khắc phục sự cố
Trang này giải quyết các sự cố vốn người 
dùng có thể khắc phục. Nếu sự cố vẫn 
tiếp diễn sau khi bạn đã thử dùng các giải 
pháp trên trang này, hãy liên hệ với đại 
diện dịch vụ khách hàng của Philips.

 Các sự cố thường gặp

Không có hình ảnh (Đèn LED nguồn 
không sáng)
• Đảm bảo đã cắm dây nguồn vào ổ 

cắm điện và mặt sau của màn hình.
• Trước tiên, đảm bảo nút nguồn ở 

mặt trước màn hình nằm ở vị trí OFF 
(TẮT), sau đó đẩy nút sang vị trí ON 
(BẬT).

Không có hình ảnh (Đèn LED nguồn 
sáng trắng)
• Đảm bảo đã bật máy tính.
• Đảm bảo cáp tín hiệu đã được kết nối 

đúng cách với máy tính của bạn.
• Đảm bảo cáp màn hình không có các 

chấu cắm bị cong trên mặt kết nối. 
Nếu có, hãy sửa hay thay mới cáp.

• Có thể đã bật tính năng Tiết kiệm 
năng lượng

Màn hình thông báo

Attention

Check cable connection

• Đảm bảo cáp màn hình đã được kết 
nối đúng cách với máy tính của bạn. 
(Cũng tham khảo Hướng dẫn khởi 
động nhanh).

• Kiểm tra xem cáp màn hình có các 
chấu cắm bị cong hay không.

• Đảm bảo đã bật máy tính.

Nút AUTO (Tự động) không hoạt động
• Chức năng tự động chỉ áp dụng ở chế 

độ VGA- Analog. Nếu không hài lòng 
với kết quả, bạn có thể thực hiện các 
điều chỉnh thủ công qua menu OSD 
(hiển thị trên màn hình).

 Ghi chú
Chức năng Auto (Tự động) không áp 
dụng ở chế độ DIV-Digital (DVI-KTS) vì nó 
không cần thiết.

Các dấu hiệu về khói hay tia lửa có thể 
nhìn thấy
• Không thực hiện bất kỳ bước khắc 

phục sự cố nào
• Ngắt ngay kết nối màn hình khỏi ổ 

cắm điện chính cho an toàn
• Liên hệ ngay với đại diện dịch vụ 

khách hàng của Philips.

 Các sự cố hình ảnh

Hình ảnh không nằm giữa tâm màn hình
• Chỉnh vị trí hình ảnh qua chức năng 

“Auto” (Tự động) trong các nút điều 
khiển chính trên menu OSD.

• Chỉnh vị trí hình ảnh qua Phase/Clock 
(Góc pha/Đồng hồ) của Setup (Cài 
đặt) trong các nút điều khiển chính 
trên menu OSD. Nó chỉ có hiệu lực ở 
chế độ VGA.

Hình ảnh rung lên trên màn hình
• Kiểm tra xem cáp tín hiệu đã được 

cắm chặt đúng cách vào bảng mạch 
đồ họa hay máy tính hay chưa.

Hiển thị hiện tượng chập chờn dọc
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• Chỉnh hình ảnh qua chức năng “Auto 

(Tự động)” trong các nút điều khiển 
chính của menu OSD.

• Loại bỏ các vạch dọc qua Phase/
Clock (Góc pha/Đồng hồ) của Setup 
(Cài đặt) trong các nút điều khiển 
chính của menu OSD. Nó chỉ có hiệu 
lực ở chế độ VGA.

Hiển thị hiện tượng chập chờn ngang

• Chỉnh hình ảnh qua chức năng “Auto 
(Tự động)” trong các nút điều khiển 
chính của menu OSD.

• Loại bỏ các vạch dọc qua Phase/
Clock (Góc pha/Đồng hồ) của Setup 
(Cài đặt) trong các nút điều khiển 
chính của menu OSD. Nó chỉ có hiệu 
lực ở chế độ VGA.

Hình ảnh hiển thị nhòe, không rõ hoặc 
quá mờ
• Chỉnh độ tương phản và độ sáng trên 

menu Hiển thị trên màn hình (OSD).

Hiện tượng “ảnh ảo”, “ảnh thử nóng” 
hay “ảnh bóng ma” vẫn hiển thị sau khi 
đã tắt nguồn.
• Hiển thị liên tục các ảnh tĩnh trong một 

thời gian dài có thể gây ra hiện tượng 
“ảnh thử nóng”, còn được gọi là “ảnh 
ảo” hay “ảnh bóng ma”, trên màn hình 
của bạn. “Ảnh thử nóng”, “Ảnh ảo” 
hay “Ảnh bóng ma” là hiện tượng phổ 
biến trong công nghệ màn hình LCD. 
Trong hầu hết các trường hợp, hiện 
tượng “ảnh thử nóng” hoặc “ảnh ảo” 
hay “ảnh bóng ma” sẽ dần dần biến 
mất sau một thời gian màn hình bị 
ngắt điện.

• Luôn bật trình bảo vệ màn hình 
chuyển động khi bạn không sử dụng 
màn hình.

• Luôn bật ứng dụng làm mới màn hình 
định kỳ, nếu không, màn hình LCD 
của bạn sẽ hiển thị những nội dung 
tĩnh không thay đổi.

• Không thể kích hoạt trình bảo vệ 
màn hình hoặc ứng dụng nạp lại màn 
hình định kỳ có thể gây ra các sự cố 
nghiêm trọng như “thử nóng” hoặc 
“ảnh sau” hoặc “ảnh bóng ma” vốn 
sẽ không biết mất và cũng không thể 
khắc phục. Thiệt hại như trên không 
nằm trong chính sách bảo hành của 
chúng tôi.

Hình hiển thị biến dạng. Văn bản bị mờ 
hoặc nhòe.
• Cài độ phân giải màn hình máy tính 

sang cùng chế độ với độ phân giải 
màn hình gốc khuyên dùng của màn 
hình LCD.

Các chấm lục, đỏ, lam, đen và trắng 
hiển thị trên màn hình
• Các chấm còn lại là đặc tính thông 

thường của màn hình tinh thể lỏng 
dùng trong công nghệ ngày nay. Vui 
lòng tham khảo chính sách điểm ảnh 
để biết thêm thông tin.

Đèn “bật nguồn” quá sáng và gây chói 
mắt
• Bạn có thể chỉnh đèn “bật nguồn” qua 

Cài đặt đèn LED nguồn trong các nút 
điều khiển chính của menu OSD.

Để được trợ giúp thêm, hãy xem danh 
sách Trung tâm thông tin khách hàng 
và liên hệ với đại diện dịch vụ chăm sóc 
khách hàng của Philips.
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8.2 Hỏi đáp SmartControl Lite

H1. Tôi đã đổi màn hình trên PC sang 
màn hình khác và không thể sử 
dụng SmartControl, tôi cần làm gì?

Đáp: Hãy khởi động lại PC và kiểm tra 
xem SmartControl Lite có hoạt động 
không. Nếu không, bạn cần phải gỡ 
bỏ và cài đặt lại SmartControl Lite để 
đảm bảo cài đặt driver thích hợp.

H2. Các chức năng SmartControl Lite 
đã hoạt động tốt trước đó, nhưng 
giờ nó không hoạt động nữa, tôi 
có thể làm gì?

Đáp: Nếu đã thực hiện các thao tác sau, 
thì bạn cần phải cài đặt lại driver màn 
hình.

• Đã đổi bộ thích ứng đồ họa video 
sang một adapter khác

• Đã cập nhật driver video
• Các hoạt động trên HĐH như gói hoặc 

loạt ứng dụng
• Chạy Cập nhật Windows và cập nhật 

màn hình và/hoặc driver video
• Đã khởi động Windows bằng nút tắt 

hay ngắt kết nối màn hình.
• Để xác định sự cố, hãy click chuột 

phải My Computer (Máy tính của tôi) 
và click vào Properties (Thuộc tính)-
>Hardware (Phần cứng)-> Device 
Manager (Quản lý thiết bị).

• Nếu nhìn thấy “Plug and Play Monitor” 
(Màn hình cắm vào là chạy) hiển 
thị trong Monitor (Màn hình), thì 
bạn cần cài đặt lại. Chỉ cần gỡ bỏ 
SmartControl Lite và cài đặt lại.

H3. Sau khi cài đặt SmartControl Lite, 
khi click vào thẻ SmartControl 
Lite, không có mục nào bật lên 
sau một lát hoặc thông báo lỗi 
hiển thị, điều gì đã xảy ra?

Đáp: Có thể là do bộ thích ứng đồ họa của 
bạn không tương thích với ứng dụng 
SmartControl Lite. Nếu bộ thích ứng 

đồ họa là một trong số các nguyên 
nhân nêu trên, thử tải về driver bộ 
thích ứng đồ họa mới nhất từ website 
của các công ty tương ứng.
Cài đặt driver. Gõ bỏ SmartControl 
Lite và cài đặt lại một lần nữa.
Nếu nó vẫn không hoạt động, thì 
rất tiếc là bộ tương ứng đồ họa 
không được hỗ trợ. Vui lòng truy cập 
website của Philips và kiểm tra xem 
driver SmartControl Lite mới nhất đã 
có sẵn hay chưa.

H4. Khi tôi click vào Product Information 
(Thông tin sản phẩm), nó chỉ hiển 
thị một phần, điều gì đã xảy ra?

Đáp: Có thể là do driver bộ thích ứng đồ 
họa của bạn không phải là phiên 
bản cập nhật mới nhất vốn hỗ trợ 
đầy đủ giao diện DDC/CI. Hãy thử 
tải về driver bộ thích ứng đồ họa 
mới nhất từ website của các công 
ty tương ứng. Cài đặt driver. Gõ bỏ 
SmartControl Lite và cài đặt lại một 
lần nữa.

Attention

Theft Deterence is Enabled

H5. Tôi đã quên mã PIN cho chức 
năng Theft Deterrence (Chống 
trộm). Tôi cần làm gì?

Đáp: Trung tâm dịch vụ Philips có quyền 
yêu cầu xác nhận và quyền hợp lệ 
để thiết lập quyền sở hữu màn hình.
Xin lưu ý chức năng chống trộm 
được cung cấp như là tùy chọn tiện 
ích miễn phí. Quản lý mã PIN là 
trách nhiệm riêng của người dùng 
cá nhân hay tổ chức vốn đã tạo ra 
mã này. Trong trường hợp quên mã 
PIN, trung tâm dịch vụ Philips có thể 
tạo lại cho bạn với mức phí nhỏ sau 
khi xác nhận quyền sở hữu của bạn. 
Xin lưu ý chức năng này không được 
bao gồm trong các điều khoản bảo 
hành chính thức.



39

8. Khắc phục sự cố & Hỏi Đáp

8.3 Hỏi Đáp chung

H1: Khi cài cài đặt màn hình, tôi cần làm 
gì nếu màn hình hiển thị "Cannot 
display this video mode" (Không 
thể hiển thị chế độ video này)?

Đáp: Độ phân giải khuyên dùng cho màn 
hình này là: 1920x1080@60Hz

• Ngắt tất cả các cáp rồi kết nối PC với 
màn hình mà bạn đã dùng trước đó.

• Trong Windows Start Menu (Menu 
khởi động Windows), chọn Settings/
Control Panel (Cài đặt/bảng điều 
khiển). Trong Control Panel Window 
(Cửa sổ bảng điều khiển), chọn biểu 
tượng Display (Màn hình). Bên trong 
Display Control Panel (Bảng điều 
khiển màn hình), chọn thẻ "Settings" 
(Cài đặt). Trong thẻ cài đặt, trong ô 
có tên 'desktop area' (vùng màn hình 
nền), chuyển thanh trượt sang mức 
1920×1080 pixels.

• Mở thẻ "Advanced Properties" (Thuộc 
tính nâng cao) và cài Refresh Rate 
(Mức nạp lại) sang 60Hz rồi click vào 
OK.

• Khởi động lại máy tính và lặp lại 
bước 2 và 3 để kiểm tra xem PC 
của bạn đã được cài sang mức 
1920×1080@60Hz hay chưa.

• Tắt máy tính, ngắt kết nối màn hình 
cũ và kết nối lại màn hình LCD Philips 
của bạn.

• Tắt màn hình rồi bật lại PC.

H2: Mức cập nhật khuyên dùng cho 
màn hình LCD là bao nhiêu?

Đáp: Mức cập nhật khuyên dùng cho màn 
hình LCD là 60Hz; nếu có bất cứ 
hiện tượng nhiễu nào trên màn hình, 
bạn có thể cài đặt mức này sang 
75Hz để kiểm tra xem mức mới này 
có loại bỏ được hiện tượng nhiễu 
hay không.

H3: Các file .inf và .icm trên đĩa CD 
là gì? Làm thế nào để cài đặt các 
driver (.inf và .icm)?

Đáp: Đây là các file driver cho màn hình 
của bạn. Thực hiện theo các chỉ dẫn 
trong sổ tay sử dụng để cài đặt các 
driver này. Máy tính có thể yêu cầu 
bạn cài các driver màn hình (file .inf 
và .icm) hoặc lắp đĩa driver khi bạn 
cài đặt màn hình lần đầu. Thực hiện 
theo các chỉ dẫn để lắp (đĩa CD kèm 
theo) thùng đựng màn hình này. Các 
driver màn hình (file .inf và .icm) sẽ 
được cài đặt tự động.

H4: Làm thế nào để chỉnh độ phân giải?
Đáp: Card video/driver đồ họa của bạn 

và màn hình sẽ cũng quyết định 
các độ phân giải có sẵn. Bạn có thể 
chọn độ phân giải mong muốn trong 
Control Panel (Bảng điều khiển) 
của Windows® qua thẻ “Display 
properties (Thuộc tính màn hình)”.

H5: Điều gì sẽ xảy ra nếu tôi quên các 
thao tác tiếp theo khi đang điều 
chỉnh màn hình qua menu OSD?

Đáp: Chỉ cần nhấn nút OK, rồi chọn 'Reset' 
(Cài đặt lại) để cài đặt tất cả trở về 
cài đặt mặc định gốc.

H6: Màn hình LCD có khả năng chống 
trầy xước?

Đáp: Nói chung bạn không nên để bề mặt 
màn hình va chạm quá mức với các 
vật khác hay và bảo vệ nó khỏi các 
vật dụng sắc hay cùn. Khi cầm màn 
hình, đảm bảo không dùng sức ép 
hay lực mạnh lên phía bề mặt màn 
hình. Điều này có thể ảnh hưởng đến 
các điều kiện bảo hành của bạn.

H7: Tôi nên lau màn hình LCD như thế 
nào?

Đáp: Để lau thông thường, hãy sử dụng 
khăn sạch và mềm. Để lau kỹ, hãy 
dùng cồn isopropyl. Không dùng 
các dung môi khác như cồn êtylic, 
ethanol, axeton, hexan, v.v...
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H8:  Tôi có thể thay đổi cài đặt màu sắc 

cho màn hình?
Đáp: Dĩ nhiên, bạn có thể thay đổi cài 

đặt màu sắc qua nút điều khiển trên 
menu OSD theo các quy trình sau,

• Nhấn “OK” để hiển thị menu OSD 
(Hiển thị trên màn hình)

• Nhấn "Down Arrow" (Mũi tên xuống) 
để chọn tùy chọn "Color" (Màu) rồi 
nhấn "OK" để vào cài đặt màu; có ba 
lựa chọn màu như sau.
1. Color Temperature (Nhiệt độ màu): 

với các cài đặt trong phạm vi 
6500K, màn hình sẽ hiển thị “nóng, 
với tín hiệu màu đỏ-trắng", trong 
khi nhiệt độ 9300K tạo ra “tín hiệu 
mát lam-trắng”.

2. sRGB (Đỏ-Lục-Lam chuẩn): đây 
là cài đặt chuẩn để đảm bảo trao 
đổi màu thích hợp giữa các thiết bị 
khác nhau (vd: máy ảnh KTS, màn 
hình, máy in, máy quét, v.v...)

3. User Define (Tự chọn): người dùng 
có thể tự chọn cài đặt màu sắc ưu 
tiên bằng cách chỉnh màu đỏ, lục 
và lam.

 Ghi chú
Đo màu ánh sáng tỏa ra từ một vật dụng 
trong khi nó được làm nóng. Số đo này 
được thể hiện dựa trên tỷ lệ tuyệt đối, (mức 
độ Kelvin). Các mức nhiệt độ Kevin thấp 
hơn như 2004K là màu đỏ; các mức nhiệt 
độ cao hơn như 9300K là màu lam. Nhiệt 
độ trung tính là màu trắng ở mức 6504K.

H9: Tôi có thể kết nối màn hình LCD với 
mọi PC, máy chủ hay máy Mac?

Đáp: Có thể. Tất cả các màn hình LCD 
Philips đều hoàn toàn tương thích 
với các PC, máy Mac và máy chủ 
chuẩn. Bạn có thể cần có đầu nói 
cáp để kết nối màn hình mới hệ 
thống máy Mac. Vui lòng liên hệ với 
nhân viên kinh doanh của Philips để 
biết thêm thông tin.

H10: Màn hình LCD Philips có hỗ trợ 
chuẩn Plug-and-Play (Cắm vào là 
phát)?

Đáp: Có, các màn hình Philips đều hỗ trợ 
chuẩn Plug-and-Play tương thích với 
Windows 8/7/Vista/XP/NT, Mac OSX, 
Linux

H11: Ảnh chập chờn hay ảnh thử nóng 
hay ảnh ảo hay ảnh bóng ma trên 
màn hình LCD là gì?

Đáp: Hiển thị liên tục các ảnh tĩnh trong 
một thời gian dài có thể gây ra hiện 
tượng "ảnh thử nóng", còn được gọi 
là “ảnh ảo” hay “ảnh bóng ma”, trên 
màn hình của bạn. “Ảnh thử nóng”, 
“Ảnh ảo” hay “Ảnh bóng ma” là hiện 
tượng phổ biến trong công nghệ màn 
hình LCD. Trong mọi trường hợp, 
hiện tượng “ảnh thử nóng” hay “ảnh 
ảo” hay “ảnh bóng ma” sẽ biến mất 
dần trong một thời gian sau khi đã tắt 
nguồn.
Luôn bật trình bảo vệ màn hình 
chuyển động khi bạn không sử dụng 
màn hình.
Luôn bật ứng dụng làm mới màn 
hình định kỳ, nếu không, màn hình 
LCD của bạn sẽ hiển thị những nội 
dung tĩnh không thay đổi.

 Cảnh báo
Các hiện tượng “ảnh thử nóng” hay “ảnh 
ảo” hay “ảnh bóng ma” sẽ không biết mất 
và bạn cần mang màn hình đi sửa. Thiệt 
hại như trên không nằm trong chính sách 
bảo hành của chúng tôi.

H12: Tại sao màn hình của tôi hiển thị 
văn bản sắc nét và các ký tự răng 
cưa?

Đáp: Màn hình LCD của bạn hoạt 
động tốt nhất ở độ phân giải gốc 
1920×1080@60Hz. Để màn hình 
hiển thị tốt nhất, vui lòng sử dụng độ 
phân giải này. 
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8. Khắc phục sự cố & Hỏi Đáp

8.4 MHL  FAQs

H1:  Tôi không thể xem hình ảnh từ 
thiết bị di động trên màn hình

Đáp:  
• Hãy kiểm tra xem thiết bị di động của 

bạn có được chứng nhận tương thích 
MHL hay không.

• Bạn cũng cần có cáp được chứng 
nhận tương thích MHL để kết nối các 
thiết bị.

• Đảm bảo bạn đã kết nối với cổng 
MHL-HDMI, và đã chọn đầu vào thích 
hợp trên màn hình qua bộ chọn đầu 
vào (mặt vát trước hoặc menu OSD 
{hiển thị trên màn hình})

• Sản phẩm được chính thức công nhận 
tương thích MHL. Vì đây là màn hình 
không nguồn, nên nếu bạn gặp phải 
bất kỳ sự cố bất ngờ nào khi sử dụng 
đầu vào MHL, vui lòng tham khảo sổ 
tay sử dụng thiết bị di động hoặc liên 
hệ với nhà sản xuất thiết bị di động 
đó.

Attention

No video input(MHL-HDMI)

• Đảm bảo thiết bị đi động của bạn 
chưa vào chế độ chờ (không hoạt 
động). Nếu đã vào chế độ này, thì bạn 
sẽ nhìn thấy thông báo hiển thị trên 
màn hình. Một khi thiết bị di động hoạt 
động lại, màn hình cũng sẽ hoạt động 
và hiển thị các hình ảnh. Bạn có thể 
cần đảm bảo đã chọn đầu vào thích 
hợp nếu đã sử dụng hoặc kết nối với 
bất kỳ thiết bị nào khác

H2.  Tại sao hình ảnh hiển thị trên màn 
hình có chất lượng kém?  Thiết bị di 
động của tôi nhìn có vẻ tốt hơn nhiều.

Đáp:  

•	 Chuẩn	MHL	định	rõ	thông	số	1080p	
@30hz	cố	định	cho	đầu	ra	và	đầu	
vào.	Màn	hình	tương	thích	với	chuẩn	
này.	Chất	lượng	hình	ảnh	tùy	thuộc	
vào	chất	lượng	của	các	nội	dung	gốc.	

•	 Nếu	nội	dung	có	độ	phân	dải	cao	(ví	
dụ	như	HD	hoặc	1080p),	thì	nó	sẽ	
hiển	thị	ở	dạng	HD	hoặc	1080p	trên	
màn	hình	này.	Nếu	nội	dung	gốc	có	
độ	phân	giải	thấp	(ví	dụ	như	QVGA),	
thì	nó	có	thể	nhìn	có	vẻ	tốt	hơn	trên	
thiết	bị	di	động	do	cỡ	màn	hình	nhỏ,	
nhưng	sẽ	nhìn	có	vẻ	kém	chất	lượng	
hơn	trên	màn	hình	lớn	này.

H3.  Tôi không thể nghe âm thanh từ 
màn hình.

Đáp: 
•	 Đảm	bảo	hàn	hình	của	bạn	có	các	loa	

tích	hợp	và	âm	lượng	được	bật	trên	
cạnh	màn	hình	cũng	như	trên	cạnh	
thiết	bị	di	động.	Bạn	cũng	có	thể	sử	
dụng	các	tai	nghe	tùy	chọn.

•	 Nếu	màn	hình	không	có	các	loa	tích	
hợp,	thì	bạn	có	thể	cắm	các	tai	nghe	
tùy	chọn	vào	đầu	ra	trên	màn	hình.	
Vui	lòng	đảm	bảo	đã	bật	âm	lượng	
trên	cạnh	màn	hình	cũng	như	trên	
cạnh	thiết	bị	di	động.

Để có thêm thông tin hoặc câu hỏi 
thường gặp (FAQ), vui lòng truy cập 
trang web chính thức của tập đoàn 
MHL: 

http://www.mhlconsortium.org
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